Copyright Notice

2017 P2 Energy Solutions. All rights reserved. No reproduction without written permission.

Version 2.0

While all reasonable care has been taken in the preparation of this document, no liability is accepted by the authors, P2 Energy Solutions, for any errors, omissions or misstatements it may contain, or for any loss or damage, howsoever occasioned, to any person relying on any statement or omission in this document.

Any questions regarding this document should be forwarded to:

P2 Energy Solutions
1670 Broadway, Suite 2800
Denver, CO 80202
United States
# Table of Contents

## Course Overview .......................................................... 4
- Audience and Prerequisites ........................................... 4
- Course Objectives ......................................................... 4
- Agenda ........................................................................... 4

## Lesson One Access IDEAS Software, Help and Support .................. 5
- IDEAS Modules .............................................................. 5
- Logging in to IDEAS ....................................................... 6
  - *How to Log In* ........................................................... 6
- How to Open Multiple Modules ....................................... 6
- Master Login .................................................................... 6
  - *How to Log In with Master Login* ................................ 7
- How to Log Off ............................................................... 7
- Practice Exercise 1: Log In and Out of IDEAS .................... 8
- Practice Exercise 2: Use Master Login .............................. 9
- How to Get Help ............................................................... 10
  - *How to Print Help* ...................................................... 10
  - *How to Locate a Topic* ............................................... 10
  - *How to Search the Help Document* .............................. 10
- How to Contact P2 Support .............................................. 12
  - *How to Access the P2 Customer Portal* ......................... 12
  - *How to Access Free Customer Portal Online Training* ..... 12
  - *How to Access Customer Portal Training Guide* ............ 12
  - *Error Logs or Messages* ............................................. 12
- Practice Exercise 3: Access and Navigate Help .................... 13

## Lesson Two MENU SECURITY .......................................... 14
- Menu Security .................................................................. 14
- Menu Security Example .................................................. 14

## Lesson Three MAIN WINDOW FEATURES .......................... 17
- Menu Bar ......................................................................... 17
- Speed Buttons .................................................................. 18
- Report Wizard Icon ........................................................ 18
Lesson Four PROGRAM FORMS ............................................................. 20

Program Types .................................................................................. 20
Program Navigation ........................................................................... 20
   Program Tabs ................................................................................ 20
   Program Fields ............................................................................ 21
   Navigation Elements ................................................................... 21
Program Data Entry Search Functions .................................................. 24
   How to Use a Simple Drop-down List ........................................... 24
   How to Search with Complex List and Search Function ............... 24
   How to Search with Multiple Search Criteria ............................. 26
How to Enter Formatted Data ............................................................. 29
   How to Enter Dates ..................................................................... 29
   How to Enter Dates Manually .................................................... 29
   How to Enter Numbers ............................................................. 29
How to Save a Record .................................................................... 30
How to Delete a Record .................................................................. 30
How to Exit a Program Screen ......................................................... 30
Practice Exercise 5: Navigate an IDEAS Program ............................ 31
Course Overview

IDEAS UI Navigation I: Menus and Programs is the first of a 3-module sequence. This module is for all IDEAS users and covers how to log in and out, access menus and programs of IDEAS modules, get help and support, and use menus, tool bars, buttons and other navigation features.

The two follow-on courses are:
• IDEAS UI Navigation II: Reporting (for all IDEAS users)
• IDEAS UI Navigation III: Architecture (for IDEAS technical users and IT administrators)

Audience and Prerequisites

We recommend that you take this class during your company’s implementation of IDEAS software, or if you are a new IDEAS user. There are no prerequisites for this course.

Course Objectives

With successful completion of this course, students will be able to:
• Log on, log off and access IDEAS Help documentation
• Access P2 Customer Support Portal, documentation and online training
• Access IDEAS menus and processes
• Navigate IDEAS menus and processes using the menu bars, program tool bars and buttons, keyboard commands and other navigation features

Agenda

• Getting Started
  o Log in and Log out
  o Master Login
  o Access Help documentation
  o Access Support (P2 Customer Portal)
• IDEAS Main Window Features
• Working with Forms
  o Types of Forms
  o Navigating Forms
Lesson One Access IDEAS Software, Help and Support

IDEAS Modules

In the IDEAS software architecture, each module is its own executable. Multiple modules can be accessed at one time, allowing end users to work in more than one area at a time. A desktop shortcut, usually named IDEAS, provides access to a program group containing all licensed IDEAS modules for that user. The installation creates an IDEAS program group in the Start menu. Users can create a shortcut folder on their desktop, but it is not created by default. The folder contains shortcuts to each module.
Logging in to IDEAS

How to Log In

1. Double-click your IDEAS desktop shortcut.
2. Double-click an IDEAS module shortcut, for example, General Ledger.EXE. The IDEAS User Login window displays.

![IDEAS User Login Window](image)

3. Enter your login credentials in the User Name and Password boxes. Click OK.

The IDEAS main window for the selected module opens.

How to Open Multiple Modules

1. Follow the steps above under How to Log In.
2. Then select a second module shortcut and log in a second time.

Each time you log into a new module, the previous module is minimized to the Windows task bar at the bottom of the window. Click to access each module.

**Warning!** Each module that you open uses a single IDEAS user license.

The following section, *Master Login*, gives an alternate way to open multiple modules using only one IDEAS user license.

Master Login

Master Login utility provides these benefits:

- Log in to IDEAS once
- Open modules without re-logging in
- Uses a single user license regardless of how many modules are opened by a single user
How to Log in with Master Login

1. Double-click your IDEAS desktop shortcut.
2. Double-click the Master Login shortcut. The IDEAS User Login window displays.
3. Enter your login credentials in the User Name and Password boxes. Click OK. The Master Login is minimized to the task bar.

4. Access a module shortcut for each IDEAS module that you need to use. With Master Login, your credentials are passed along and you will not be prompted to log in. You will use only one user license when you access multiple modules.

Example: You need to access two modules, General Ledger and Joint Interest Billing. Use Master Login and then access the GL and the JIB modules. You will have only used one license; however, your computer task bar will show three sessions:

How to Log Off

To log off, use one of these methods:

- Click the close button at the top, right of the IDEAS main window.

- From the top menu bar, select the File menu and choose Exit.
Use a keyboard shortcut: \texttt{Ctrl+X}.

Use a keyboard shortcut: \texttt{Alt+F4}.

**Practice Exercise 1: Log in and Out of IDEAS**

<table>
<thead>
<tr>
<th>FIELD</th>
<th>VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDEAS desktop shortcut</td>
<td><img src="image" alt="IDEAS" /> (This may be slightly different in client environment.)</td>
</tr>
<tr>
<td>Module #1 Shortcut</td>
<td>General Ledger shortcut</td>
</tr>
<tr>
<td>Module #2 Shortcut</td>
<td>Accounts Payable shortcut</td>
</tr>
<tr>
<td>User Name</td>
<td>Your IDEAS User Name</td>
</tr>
<tr>
<td>Password</td>
<td>Your IDEAS password. Note: Your password is case sensitive.</td>
</tr>
</tbody>
</table>

Use values in the table (above) and follow these steps:

1. Double-click your IDEAS desktop shortcut.
2. Double-click an IDEAS module shortcut.
3. Repeat steps 2 and 3 to access a second module.
4. Log off each module using one of the methods described in this lesson.
5. How many user licenses were used?
Practice Exercise 2: Use Master Login

Use values in the table (above) and follow these steps:

1. Double-click your IDEAS desktop shortcut.
2. Double-click Master Login shortcut.
3. Repeat steps 2 and 3 in Practice Exercise 1 to access GL and AP modules.
4. How many user licenses were used?

**Password Note:** Passwords are not necessarily case sensitive. They are only case sensitive if Enforce Complex Passwords is turned on in the System Options program of the System Security module.
How to Get Help

IDEAS software provides Help documentation for each module that displays as a PDF file in Adobe Acrobat Reader. To access Help, use one of these methods:

- From the Help menu at the top of any module’s main window, select **Index**.
- Use a keyboard shortcut: **Shift+F1**.
- On the main window tool bar, click the Help speed button.
- From within a program screen, on the icon bar, click the Help icon.

Standard Adobe Reader functions are available for navigating the Help document, such as Search, Print and Save.

How to Print Help

To print the Help documentation from Adobe Reader, use one of these methods:

- Click the Print icon located on the icon bar.
- From the **File** menu, choose **Print**.
- Use a keyboard shortcut: **Ctrl+P**.

The Windows Print dialog box displays. Select the printer and enter the page numbers that you want to print.

How to Locate a Topic

To locate a topic in Help documentation:

1. Review the Help documentation **Table of Contents**.
2. Click the page number next to the topic you want to view.

How to Search the Help Document

To search for a topic, use one of these methods:

- From the Edit menu choose Find.
- Use a keyboard shortcut: **Ctrl+F**.

Then enter the text you are searching for in the Find text box and press Enter on your keyboard. Each time you press Enter, you will be taken to the next instance of the topic.
Example: General Ledger Help Documentation Displayed in Adobe Reader
How to Contact P2 Support

You can access IDEAS support through the P2 Customer Portal.

P2 Customer Portal provides:
- A direct channel to the P2 Support team
- The ability to log cases, search on cases and documents, and post inquiries.

How to Access the P2 Customer Portal

1. Access the P2 website: www.p2energysolutions.com
2. Click the Support tab and log in.

How to Access Free Customer Portal Online Training

Recorded online training to teach you how to use the Portal is available at no cost. To access training, log in to P2’s website via the Support tab and then click the P2 Customer Portal Training tab.

How to Access Customer Portal Training Guide

A free training guide download is available to you on the Portal.
1. Click the Content tab.

Error Logs or Messages

Any time you receive an unexpected error message in a screen and you plan to create a case on the P2 Customer Portal, complete the following steps to save the message:
IDEAS

UI Navigation I: Menus and Programs Training Guide

1. While the message is displayed on your screen, press the print screen button on your keyboard. This will copy the message to your Windows clipboard.
2. Open a new Microsoft Word document.
3. Paste the message into the Microsoft Word document using one of these methods:
   - Go to the edit menu and select Paste.
   - Press Ctrl+V on your keyboard.
   - Click the paste icon .

Practice Exercise 3: Access and Navigate Help

1. On the GL module main window, from the Help menu click Index, or click the speed button.

2. Move to the Monthly Processing Procedures section of the documentation: From the Table of Contents, locate Monthly Processing Procedures and click its page number.

3. Find the text: validation tab. From the Edit menu choose Find and enter validation text in the search box.

4. Print the topic: Click the print icon located on the icon bar.
Lesson Two MENU SECURITY

Menu Security

When you log in to IDEAS, the system compares the user ID to the Menu Security tables. The Menu Security tables store security configurations set up by a System Administrator for each user. These configurations allow or restrict access to:

- Individual processes
- Entire menus
- Speed buttons

Menu Security Example

The IDEAS System Administrator created a user called Inquiry. The user was given access to:

- Reports
- Inquiries

The Inquiry user was not given the ability to:

- Create journals
- Validate journals
- Post journals

When the Inquiry user logs in, IDEAS compares the Inquiry user ID to the Menu Security tables.
IDEAS

UI Navigation I: Menus and Programs Training Guide

IDEAS then allows or restricts access to the programs accordingly.

The Journals menu is still available, but all the items that would allow this user to create journals have been disabled. This user still has access to Batch Inquiry.

![Journals Menu](image)

This user still has access to journal reports.

![Journal Reports Menu](image)
In Chartmaster, this user does not have the ability to change elements or to make changes to them.

However, this user still has access to Account Information, Element Inquiry and other submenus whose functions were not restricted in the Menu Security tables.

Entire menus can be disabled. The Utilities menu and all its submenus were disabled for this user, as well as the Customizer menu and its submenus.

Additionally, corresponding speed buttons are disabled by the Menu Security process.
Lesson Three MAIN WINDOW FEATURES

Menu Bar

Each IDEAS module provides a horizontal main menu bar across the top of the main window.

Functions that are accomplished by each IDEAS module are organized into drop-down menus from the main menu bar. The menus provide standard menu options (for functions needed in all modules) and module-specific menus (for functions that are specific to that module).

- Standard menus
  - File menu
  - Window menu
  - Help menu
- Module-specific menus

The following list is an example of the menus in the General Ledger module:
  - Journals menu
  - Chartmaster menu
  - Reports menu
  - Inquiries menu
  - Utilities menu
  - Customizer menu
IDEAS

UI Navigation I: Menus and Programs Training Guide

Speed Buttons

IDEAS software provides speed buttons below the menu bar on the main window. The speed buttons vary with each module. These buttons provide quick access to a set of commonly used functions for that module, as well as quick access to the Help documentation. As an example, the following list of monthly processing procedures may be accessed with speed buttons on the GL module’s speed bar.

- JE – Journal Entry Processing
- JC - Journal Entry Corrections
- JV - Journal Entry Account Validation
- JI - Journal Batch Inquiry
- JP - Journal Entry Posting
- AI – Account Balance Inquiry
- JD – Journal Definition Maintenance
- – Help / online documentation

Report Wizard Icon

The Report Wizard icon displays at the top, right side of the main window and provides fast access to the Report wizard tool. The Report Wizard allows you to create custom “ad hoc” reports using Crystal Reports.

Session Status Information

Several text fields located at the top, center of the main window provide information about the profile, user, and login date and time of the current session:

- Current profile accessed
- Current user that is logged in
- Date and time that they logged in
How to Select a Program from the Main Window

Use one of these methods to select an IDEAS function (also called a program or screen):

- Select the function from a menu.
- Use the function speed button located below the menu bar.
- Use the keyboard shortcut shown next to the menu option.

Practice Exercise 4: Navigate the Main Window

1. From an IDEAS module main window, from the menu bar access a program of your choice. Use the close button on the top right corner to close the program.

2. From an IDEAS module main window, use one of the navigations to access the online Help. Use the close button on the top right corner to close the program.

3. From an IDEAS module main window, use a speed button to access the Report Wizard. Use the close button on the top right corner to close the program.

4. Use information found on the main window to complete the following table.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current profile</td>
<td></td>
</tr>
<tr>
<td>Current user</td>
<td></td>
</tr>
<tr>
<td>Login date</td>
<td></td>
</tr>
<tr>
<td>Login time</td>
<td></td>
</tr>
</tbody>
</table>
Lesson Four PROGRAM FORMS

IDEAS modules provide several types of functions, sometimes called programs, screens, or forms, each with their own features.

Program Types

Three main types of IDEAS programs:

- Setup (Example: Journal Definitions screen)
- Processing (Example: Journal Entry screen)
- Reporting or Inquiry (Example: Journal Batch Inquiry)

Additionally, IDEAS has programs devoted to system security functions, which are covered in the IDEAS IT Administration course modules.

Program Navigation

Each IDEAS program provides fields for data entry and display, as well as standard user navigation features.

Program Tabs

Some IDEAS program forms contain tabs. Tabs provide quick access to multiple screens, each of which provides a related function. For example, in the General Ledger module, Journal Batch Entry Processing has four tabs (screens) to provide the following functionality:

- Batch control
- Control totals
- Line item entry
- Account validation
Program Fields

A field is an area of the screen where system data is displayed. Some data entry fields provide default values that you can accept or modify. Other fields show display-only data. Data can come from tables where it is stored, from processing that has just occurred, or may be entered by users through the keyboard.

Navigation Elements

Navigation features include elements such as:

- **Program/function tabs** - Provide for easy access of related screens. In this example, the Batch Entry screen is selected. Other available screens are represented by their tabs: Control Total, Validation and Line Items.

- **Drop-down lists** - Provide easy selection of data

- **Text boxes** - Allow data entry or display, often accompanied by a Search button. Text boxes for data entry have a white background.

- **Display-only Fields** - Display information but do not permit you to modify the field value. Display-only fields have the same background color as the surrounding screen, rather than a white background.

- **Search icons** (spy glass) - Provide pop-up windows for data selection, sorting of selection lists or further data selection search and drill down

- **Check boxes** - Designate Yes or No input

- **Horizontal and vertical scroll bars** - For additional screen or report information
UI Navigation I: Menus and Programs Training Guide

- **Standard screen buttons** - Provide standard screen functions such as Help, Close or Cancel

- **Process-specific buttons** - Provide specific functions for a screen, such as Execute, Inactivate, Delete, Copy, Print or Export

- **Radio buttons** - Provide selection of a simple choice

- **Scroll arrows** - Screens that show report output may have arrows that let you navigate forward, backward, to the report first page or to the report last page.
### 1.1.1.1 Table - Program Icon Bar

<table>
<thead>
<tr>
<th>ICON</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Close a program</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Access Help documentation</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Open a new record</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Save a record</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Delete a record</td>
</tr>
</tbody>
</table>
Program Data Entry Search Functions

To make data entry easier, many screens include:

- Simple drop-down lists for selecting data
- Data entry boxes with Search ("spy glass") button to display more complex lists
- Search boxes with single or multiple search criteria
- Sort capability for searching lists

The following sections show examples for search box functions from the General Ledger module.

How to Use a Simple Drop-down List

The Chart Master function’s Element Maintenance screen provides a simple drop-down list to help with data entry at the Element Name field. Click the arrow and then select a choice.

How to Search with Complex List and Search Function

The Element Maintenance screen provides a more complex drop-down list with a search box to help with data entry at the Element ID field.
IDEAS

UI Navigation I: Menus and Programs Training Guide

Search Steps

1. Click the search icon (🔍 spy glass) to display a list of both IDs and their descriptions.
2. Then use one of these methods for data entry:
   - Select a choice from the list and then click OK.
   - Double-click a choice.
   - Use the text search box provided to enter an element ID. The software highlights the first match as you enter the text string.
3. Click OK.
   The value you selected now displays in the data entry field.
How to Search with Multiple Search Criteria

In this example, the Invoice Entry screen provides a search option for the Batch field.

This search box provides multiple fields in the selection list (batch number and the date that the batch was created), and allows multiple search criteria.

**Sort Function**
You can sort list columns with an ascending or a descending sort.

- **Ascending Sort**
  - Text – A to Z
  - Numbers - smallest to largest
  - Dates - past to present

- **Descending Sort**
  - Text - Z to A
  - Numbers – largest to smallest
  - Dates – present to past
Sort Function Steps

Ascending Sort:
Click a column header to sort the column in ascending order. In this example, we clicked the Batch No. column header to sort the batches in ascending text string order.

![Ascending Sort Example](image1)

Descending Sort:
Click the column header again to sort the list in descending order.

![Descending Sort Example](image2)
We can also sort the Date column. In the following example, the date field is sorted in descending order (present or most recent to past).

**Search Function Steps**

In this example, the search box allows you to enter either a batch number or a date in the search box. Follow these steps for multiple criteria search boxes:

1. Click the column header of the criteria you want to provide a search value for. In this example, we click the Date header.

2. In the search box, enter a date.

3. Click OK to return the value to the Batch field.
How to Enter Formatted Data

Data entry of dates and numbers require that you follow these guidelines.

How to Enter Dates

To change a default date or enter a new date, use one of these methods:

- Enter the date manually at the text box, following the guidelines described in the next section.
- If a calendar icon displays next to the date field, click the icon and select a date.

How to Enter Dates Manually

When typing a date into a Data field, IDEAS uses the following formats:

- You must always enter day, month and year
- Day, month and year order are dependent on the regional settings of the computer. IDEAS recognizes the date format of the computer, so if the format is mm/dd/yyyy or dd/mm/yyyy the users will enter the date in the format they are accustomed to.
- At Date fields, IDEAS recognizes the string as a date and parses it accordingly. If it does not parse as a date, then an error message will display.

To enter a date manually, on a machine that uses the mm/dd/yyyy format, you can use any of the following formats:

- MM/DD/YY (Example: 08/10/12 for August 8th, 2012)
- M/DD/YY (Example: 8/10/12 for August 8th, 2012)
- MM/DD/YYYY (Example: 08/10/2012 for August 8th, 2012)
- You can also enter the dates without the “/” characters (forward slashes)
  Example: 081212 for August 8th, 2012

How to Enter Numbers

When typing a number into a Numeric field, IDEAS uses the following formats:

- Use nn.nn for a decimal number.
- To enter a value less than one (1.0) the leading zero is optional.
  Example: Enter 0.5 or .5
- To enter a whole number, a decimal point or ending zeros are optional.
  Example: Enter 100 or 100.00
- Use -nn for a negative number.
How to Save a Record

- From the screen’s icon bar, click the Save icon.
- Click the Save button at the bottom of the screen, if it is available.

How to Delete a Record

Use one of these methods to delete a record:

- From the screen’s icon bar, click the Delete icon or .
- Click the Delete button at the bottom of the screen, if it is available.

How to Exit a Program Screen

- Click the Close button at the bottom of the screen.
- Click the close form button in the top, right corner of the screen.
- Click the close icon.

IDEAS always prompts the user to save data if they have not previously saved.
Practice Exercise 5: Navigate an IDEAS Program

Practice navigation in IDEAS by completing the following tasks. **Note:** You may need to tailor your specific module, fields and data choices to the data on your company’s system.

1. Select a function using the main menu bar:
   a. From the GL module main window, click Chart Master and then select Element Inquiry screen.

2. Use a drop-down list to enter data:
   a. At the Element Name field, click the arrow.
   b. From the drop-down list, click Account.

3. Use a search icon (spy glass) to access a list of both IDs and their descriptions:
   a. At the Element ID field, click the search icon.
   b. Use the scroll bar to locate an ID and then click to select, OR Enter a valid ID at the text search box and then click to select.

4. Exit the program:
   a. Click the Close button.

5. Select a function using the speed bar:
   a. Click on the JC speed button to access the Journal Entry Corrections function.

6. Exit the program:
   a. Click the close form button in the top, right corner.

7. Mark each of the following statements about search boxes with multiple criteria as True or False:
   a. When using a multiple criteria search box, before entering the search text you must first click the column header of the criteria you want to provide a search value for. True or false?
   b. To sort a column of numbers from largest to smallest in a search box listing, simply click the column header once. True or false?
   c. To choose a value from a list and return it to the data entry field, either click on a list value and then click OK, or simply double-click on the value. True or false?
Answers to #7, True-False Questions

Question 7a – True
Question 7b – False
Question 7c – True